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This section helps you get the most out of this Guide.  

In This Chapter  

Who This Guide Is For........................................................................................ 1 
What This Guide Covers .................................................................................... 1 
What You Should Already Know ........................................................................ 1 
Typographical Conventions ............................................................................... 2 
Your Feedback Please ........................................................................................ 2 

 
 

Who This Guide Is For 

This Guide is for anyone who uses Author-it. 
 

What This Guide Covers 

This Guide tells you about: 

8 The Author-it Interface (see "Introducing the Author-it Interface" on page 7) 

8 Understanding Author-it's Concepts (on page 43) 

8 The Documentation Process With Author-it  (on page 51) 

8 Using the Author-it Importer (on page 63) 

8 How To Use Author-it (on page 105) 

8 Offline Authoring (on page 401) 

8 Using Author-it Project Manager (on page 417) 

8 The Author-it Objects and Their Properties (see "The Author-it Objects" on page 433) 
 

What You Should Already Know  

Before you read this Guide you need to be comfortable working with the Windows 
environment and its applications. For information about this, refer to the separate Windows 
user documentation, including the Windows online Help system (see "Getting Help About 
Microsoft Windows" on page 4). 
 

Chapter 1 
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Typographical Conve ntions  

Before you start using this Guide, it is important to understand the terms and typographical 
conventions used in the documentation. 

The following kinds of formatting in the text identify special information. 

Formatting convention  Type of Information  

Special Bold Items you must select, such as menu options, 
command buttons, or items in a list. 

Emphasis Use to emphasize the importance of a point, 
or for variable expressions such as 
parameters. 

Monospace  Information that you must type, or 
information like folders and filenames. 

CAPITALS Names of keys on the keyboard, for example, 
SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations where you must press and 
hold down one key and then press another, 
for example, CTRL+P, or ALT+F4. 

Tab > Command Group > 
Command 

Command option paths are written in the 
order you access a command button from the 
ribbon, for example, Edit > Insert > Insert File 
Object. 

 

 

Your Feedback Please 

To help us improve what we offer you, we would like your feedback about this Guide, and 
about any other aspect of Author-it. Go on, we can take it (and that includes compliments, 
too). Every comment counts, as far as we are concerned. You'll find we're very responsive, and 
we act on your suggestions as swiftly as we can. 
 

Contacting Us 

Author-it Software Corporation 
PO Box 300-273 
Albany 0752, Auckland 
NEW ZEALAND 
Ph: +64 (9) 9155070 
Fax: +64 (9) 9155071 
Email: info@author-it.com 
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This section describes how to get help when you have questions or problems using Author-it. 

In This Chapter  

Many Ways to Get Help ..................................................................................... 3 
Using Author-it's Help System ........................................................................... 4 
Using Author-it's Product Documentation ......................................................... 5 
Logging a Support Case ..................................................................................... 5 

 
 

Many Ways to Get Help 

There are many ways to get help when you have questions or problems while working with 
Author-it. 
 

Help Yourself  

Most people like to be able to find their own answers. It's often quicker than other ways, and 
it's usually more satisfying. There are a few options when you want to find the answers 
yourself. If you can't find the answer quickly, don't hesitate to ask us for help directly. 

8 Use the standard HTML Help system (see "Using Author-it's Help System" on page 4) that 
ships with Author-it.  

8 Use the printed product documentation (see "Using Author-it's Product Documentation" 
on page 5) about Getting Started With Author-it, Using Author-it, Using Author-it 
Administrator, Using Author-it Project Manager  and Using Author-it Localization 
Manager. 

8 Use our online Knowledge Center (http://www.author -it.com/kc/index.mv), which 
contains the entire suite of documentation for all Author-it products, as well as answers 
to frequently asked questions (FAQS), troubleshooting tips, and information on how you 
can customize Author-it to meet your needs. To go there, press the Help button and 
choose Author-it Website > Knowledge Center. 

 

Ask Other People Who Use Author -it  

When you have a problem or question that does not require an urgent answer, you can ask 
the members of the free online Author-it User Group http://www.author -
it.com/?page=usergroup. This is also a particularly good option when you have a question 
about different ways of implementing Author-it. 
 

Ask Us For Help 

We pride ourselves on our responsive, friendly support. Author-it offers a variety of support 
options (see Support page - http://www.author-it.com/index.mv?servicess) which allow you 
to log cases with our online Help desk (see "Logging a Support Case" on page 5) when you 
have questions, problems or suggestions about Author-it. 
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Using Author -it's Help System  

Author-it's HTML Help system contains most of the information you'll need to successfully 
work with Author-it. 

4 To Use Author-it Help 

1) Press the Help button and choose Contents. The HTML Help file opens, and the most 
recently viewed tab is shown first. 

2) Find the information you need by: 

4 Using the Contents tab. Read about finding the information you need in this Guide. 

4 Using the Index tab to find topics containing those terms that have been indexed. 

4 Using the Search tab to find all occurrences of a word in the Help file, no matter how 
trivial. 

 

Getting Context Sensitive Help  

Use Author-it's context-sensitive help to find out about each field or screen you're working 
with. 

4 To Get Context Sensitive Help 

1) Choose the screen and tab you want help on, then 

2) Press the F1 button. The Help topic for that screen or tab pops up. 

3) When you've finished reading, close the window. 
 

Getting Help About Microsoft Windows  

We assume you already know how to use standard Microsoft Windows applications. For more 
information about using Windows applications, please refer to the Windows user 
documentation - including the online Help which you can open by: 

8 Choose the Windows Start button, then choose Help. 

-or- 

8 Click on a blank part of your Windows Desktop, then press the F1 key at the top of your 
keyboard. 

 



 Chapter 2  |   Getting Help  

 Page 5  

Using Author -it's Product Documentation  

Author-it's product documentation set helps you use the range of Author-it programs. The 
documents are: 

8 The Getting Started With Author-it Guide, which explains how to install Author-it, and 
includes a Tutorial to get you started. 

8 The Using Author-it Guide, which explains how to use the Author-it program.  

8 The Using Author-it Administrator Guide, which explains how to use the separate Author-
it Administrator program used to manage user security, Library administration, and other 
settings. 

8 The Using Author-it Project Manager Guide, which explains how to use the separate 
Author-it Project Manager program that manages projects and tasks. 

8 The Using Author-it Localization Manager, which explains how to use the separate 
Author-it Localization Manager to manage and produce documentation in multiple 
languages. 

All documentation can be downloaded from the Author-it website (http://www.author -
it.com/index.php?page=documentation), or viewed online in the Author-it Knowledge Center 
(http://www.author-it.com/kc/index.mv). 
 

Logging a Support Case 

Sometimes you can't find the answer you need on your own. We're happy to lend a helping 
hand. 

4 To Log a Support Case 

1) Go to the Help desk page on our website: 

4 Press the Help button and choose Log Support Call. 

-or- 

4 In your Internet browser, go to the My Author-it Client Portal (http://my.author-
it.com/)  

You'll need to type in your email address, and password. If you haven't registered on the 
Author-it website, you'll need to do this first. Select the Register link and follow the 
wizard. Make sure to enter a valid email address as an email is sent to that address to 
activate your account. 

When logging a case, you are prompted to enter details including the build of Author-it 
you are using. Find out which Build (see "Finding Which Build of the Software You Are 
Using" on page 6) of the Author-it program you are using. 

2) Write a brief Subject which says what the case is about, in as few words as possible. 

3) Tell us your problem, question or suggestion. Please log only one issue in each case, so 
we can pass them easily between the appropriate people on our team. 

If you're logging a problem, please write exactly what you were doing and where, so we 
can quickly find an answer for you - without a flurry of emails seeking and supplying more 
details. Paste the text of any error messages that appear. To solve a problem we often 
need to reproduce it - so if you can describe exactly what steps we have to take, that 
helps too. Think of it as a procedure that you're writing (Step 1 - open Author-it, then 
open the Library called XYZ, Step 2 ...). The more you tell us, the easier it is for us to help 
you swiftly. 

http://www.author-it.com/index.php?page=documentation
http://www.author-it.com/index.php?page=documentation
http://www.author-it.com/kc/index.mv
http://my.author-it.com/
http://my.author-it.com/
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4) Click on the Save button. You'll get a confirmation that the case has been successfully 
logged (and an email will also follow). Note the case number. 

 

Finding Which Build of the Software You Are Using  

When you log a Support Call (see "Logging a Support Case" on page 5), we need you to tell us 
exactly which Build of Author-it you are using. This is easy to find. 

4 To Identify the Software Build: 

1) Press the Help button (near the top-right corner) and choose About Author-it Editor. A 
window appears, containing details about the software including the Version you are 
using (for example, 5.3.48.4159). 

2) The Build is displayed in brackets (for example, Build 5.3.48.4159). 
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This Chapter describes the work environment and the interface elements you will encounter 
while you're using Author-it. 

In This Chapter  

Ribbons, Tabs, and Commands .......................................................................... 8 
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Ribbons, Tabs, and Commands 

One of the first changes you'll notice in Author-it 5 is that menus have been replaced with 
Ribbons. The Ribbon is designed so you can quickly find the commands you need by bringing 
menu options into full view. Whether you are an Author or Designer, or if you are Reviewing 
or Publishing your documents, you can find the commands you need at a glance.   

The Ribbons contain a series of role-based tabs for working in the Library, or in the Editor. 
Each tab includes commands that are grouped according to an action, for example formatting 
text, or inserting images, symbols, and links. Some command groups also include a Dialog Box 
Launcher , giving you immediate access to settings for the action you're working with.  

In addition to the standard tabs, there are also context-based tabs that only display when you 
are completing certain actions. An example is the Layout tab that contains all of the 
commands for formatting tables. When the cursor is inside a table the Layout tab is accessible, 
when you continue working with topic text the Layout tab is hidden.   

 

 

 Tab 

 Command Group 

 Dialog Box Launcher  

 Command 
 

In our procedures you'll notice that the naming convention we use is based on the "path" to 
the command, Tab > Command Group > Command, for example, Edit > Insert > Insert File 
object. 
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Library Explorer  

The Library Explorer is your base for working with all the objects in your Library. This is where 
you store and select the components that you'll assemble into documents. 

 
Drag and Drop objects from the Library Explorer into your Books, Topics, or other 
objects. You can use the shortcut menu to work with your objects. 

Author-it's main window gives you access to the objects in your Library. The main window 
includes the Library Command Ribbons, Object List, and Navigation Pane (giving access to 
Folders, Search, Project Management, and Publishing). 

 

 

 

 Author-it Button 

 Command Ribbons 

 Library Folder List 

 Navigation Pane 

 Preview Pane 

 Object List 
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Author -it Button Menu - Main Window  

The Author-it Button is located in the top left corner of the main window. When selected, the 
button's menu is opened giving you access to general library commands, and the Author-it 
Options window. 

 

This Button Does This 

 
Used to close the current library and open a library chosen 
from the Select Library window (Open Recent tab). 
Alternatively, select a library from the Recent Libraries list.  

Note: Close all library windows before switching to a 
different library. 

 
Used to close the current library and create a new library 
using the Select Library window (New Library tab). 

 
Opens a window listing the variables used in the library. Use 
the window to drag and drop variables from the window 
into a topic.  

 
Opens the Customize Styles Toolbar window. Use the 
window to add, remove, and organize styles in the toolbar.  

 
Sets page margin and layout options for printing topics in 
the Editor. 

 
Opens the Author-it Options window so you can update or 
modify settings applied to the library when you login.  

 
Closes your current session in Author-it. 
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Quick Access Toolbar - Main Window  

The main window's Quick Access Toolbar lets you access folder and navigation options, and 
open the Quick Search window. 

 

This Button Does This 

 Select a folder from the recently selected folders drop-down list to 
display its contents in the object list.  

When the Folders tab is open, the selected folder is highlighted in 
the library's folder list.  

 Selects the previous folder from the recently selected folder list, 
relative to the current folder.  

 Selects the next folder from the recently selected folder list, 
relative to the current folder.  

 Opens the Quick Search (see "Author-it Quick Search" on page 
119) window.  

Recently Selected Folders List 

The recently selected folders list records the name, and order, of each folder you select or 
open during the current session. The current folder (the folder with contents displayed in the 
object list) is displayed with a check mark. When moving to the next or previous folder, the 
selection is always relative to the currently selected folder. 
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Navigation Pane  

The Navigation Pane on the left of the Author-it main window is your access point for locating 
content in the Library. Using the Navigation Pane you can: 

8 Open the Library Folders List 

8 Display Search options, as a basic text search or an advanced object search 

8 Display your Task list 

8 Open the Project Manager 

8 Open the Publishing Console 

The Navigation Pane includes the content pane where the Library Folder List, Search options, 
and user tasks are displayed. When the Publishing and Projects buttons are selected the 
content pane displays as part of the console areas for batch publishing and project 
management.  

The tabs at the bottom of the pane, can be customized to provide more room for the content 
pane. 

 
 

 The Navigation Pane 

 Navigation Pane Content 

 Navigation Pane Tabs 
 

The Navigation Pane can be resized by dragging the right border, making the pane narrower or 
wider. To resize the pane, move the cursor to the pane's right border, when the cursor 
changes a double-headed arrow drag the border to the left or right. 
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The Navigation Pane Tabs 

The Navigation tabs are located at the bottom of the navigation pane, and can be displayed 
as: 

8 Expanded, using large buttons 

-or- 

8 Collapsed, using small buttons  

-or- 

8 A combination of both views 

 

You can maximize the space in the folder pane by resizing the tabs. Either customize (see 
"Customizing the Navigation Pane" on page 14) the tabs by removing buttons, or collapse the 
tabs so the buttons are shown in a single button tray. To quickly resize the tabs just move your 
cursor to the top of the group, when the cursor turns to a double-headed arrow drag the top 
of the pane to make the area larger or smaller. 
 

Folders Tab 

 
You can organize the items in your Library using customizable Library Folders with associated 
user security. The folders in the Folders tab (see "Working with Library Folders" on page 110) 
of the Library Explorer expand and collapse the same way as the folders in Windows Explorer, 
so you can see more or less of each folder's contents. 
 

Search Tab 

 
You can find and open all objects and object templates in the Library using the Object Search 
(see "Searching for Objects" on page 114). 
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Tasks Tab 

 
Tasks are listed alphabetically in different Task Folders in the Tasks tab (see "Working with 
Tasks" on page 292) of the Library Explorer, according to their progress through the task's life 
cycle. 

The tab is visible when your organization is using the optional separate Author-it Project 
Manager program. 
 

Projects Tab  

 
The Projects Tab opens the Author-it Project Manager displaying current projects and related 
tasks. 

The tab is enabled when your organization is using the optional separate Author-it Project 
Manager program. 
 

Publishing Tab  

 
The Publishing tab is used to publish a number of jobs at once. Select the Publishing tab to 
open the publishing console. 
 

Customizing the Navigation Pane  

The Navigation control button  opens the options for customizing the navigation pane. You 
can limit the number of buttons shown (the remaining buttons are displayed as icons in the 
button tray), add or remove buttons from the pane. 
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...or use the Navigation Pane Options to change the order of the buttons. 

 
 

Object List Pane 

The Object List pane (to the right of the navigation pane) displays objects that are: 

8 Stored in the selected library folder 

-or- 

8 Identified in the results of a library search. 

For each object, these details are shown: 

8 The object's type (for example, Topic, Book, Style) - shown by the icon, which you'll 
become very familiar with. 

8 The object's description. 

8 The object template the object is based on. 

8 The last time the object was modified. 

8 Who last modified the object. 

8 The object's unique ID number. 

8 The version of the object. 

8 The object's document release state. 

8 If an object is a variant, the object's variant criteria are displayed. 
 

Preview Pane 

Depending on what preview options are selected (see "Author" on page 16), the Preview pane 
displays either: 

8 A preview of the selected object's contents, when Topics, File Objects, and Style Objects 
have been selected 

-or- 

8 A list of the selected object's Edit History 

-or- 
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8 The object's properties. 

Choosing a File Object, Style Object, Topic, or Embedded Topic from the object list displays the 
image or text in the preview pane. Choosing other objects displays their properties in the 
preview pane. 

Although you cannot edit a Topic or Book object directly in the preview pane, you can right-
click and open it from a menu. When a Topic being previewed contains a File Object, 
Embedded Topic, or Hypertext Link Object, you can right-click on that object and open it from 
the menu. 

The preview pane can be displayed (see "View Options" on page 301) below, or to the right of 
the object list. 
 

Library Command Ribbons  

Author-it's main window has several components that are described in this section: 

8 The Author (on page 16) tab. 

8 The Design (on page 18) tab. 

8 The Manage (on page 19) tab. 

8 The Import (on page 20) tab. 

8 The Publish (on page 21) tab. 

8 The Projects (on page 21) tab 

Some of the tab options carry out commands immediately, and others display a window so 
that you can enter additional information. If an option is followed by "...", it will display a 
window. Otherwise, the command is carried out immediately. 
 

Author  

The Author tab is where you'll do most of your work when creating new documents and 
projects. The ribbon contains the commands authors need to complete daily tasks. 
 

This Button Does This 

 
Create Book Creates a new Book based on the last selected template. Select the 

arrow to choose a template from the list of Book Templates.  

 
Create Topic Creates a new Topic based on the last selected template. Select 

the arrow to choose a template from the list of Topic Templates.  

 
Create File 
Object 

Creates a new File object based on the last selected template. 
Select the arrow to choose a template from the list of File object 
Templates.  

 
Create 
Hyperlink 

Creates a new Hyperlink based on the last selected template. 
Select the arrow to choose a template from the list of Hyperlink 
Templates.  

 
Create Index 
Entry 

Creates a new Index Entry based on the last selected template. 
Select the arrow to choose a template from the list of Index Entry 
Templates.  
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This Button Does This 

 
Object List Shows each object's details in the Object List of the Library 

Explorer, but no preview. 

 
Object Preview Shows a preview of an object (Topics or File objects) in the Library 

Explorer's Object List. If the object type doesn't allow a preview, its 
details are shown. 

The preview pane can be displayed (see "View Options" on page 
301) below, or to the right of the object list. 

 
Object History Shows the edit history for each object in the Object List of the 

Library Explorer. 

 
Object  
Properties 

Displays the properties for the selected object in the preview 
pane. 

 
Show 
Relationships 

Opens the Show Relationships window for the selected object. 

 
Object Locate To use Object Locate you must select an object from the search 

results object list in the Library Explorer. Object Locate highlights 
the library folder (in the Folders list) that contains the selected 
object, and displays the folder's contents in the object pane. 

 
Print Image When Author > Show > Object Preview is selected, Print Image 

shows the File or picture that will be used in your printed Word 
output. 

 
Help Image When Author > Show > Object Preview is selected, Help Image 

shows the File or picture that will be used in your Windows Help 
output. 

 
Web Image When Author > Show > Object Preview is selected, Web Image 

shows the File or picture that will be used in your HTML, XHTML, 
HTML Help, Java Help and Oracle Help outputs. 

 
List Variable 
Usage 

Lists the variables that have been used in the selected object. 

 
List Variable 
Assignment 

Lists the variables that have had new values assigned in the 
selected object. Variables using the default value are not displayed 
in the object's list. 

 
Set Variable 
Assignments 

Sets a new variable value for the selected object. 

 
Assign 
Templates 

Used to assign a template to the selected object. Templates listed 
are based on the type of object selected. Apply templates to 
individual objects, or multi-select a group of objects and assign the 
template. 

 
Assign Release 
State 

Used to assign a release state to the selected object. Apply release 
states to individual objects, or multi-select a group of objects and 
assign the release state. 

 
Find Finds text in the selected topic or book. 

 
Find and 
Replace 

Finds and optionally replaces text in the selected topic or book. 
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Design 

The Design tab is used to create less commonly used objects, and those that control your 
standards (formatting and layout). The tab contains buttons for ten types of objects. Click on a 
drop-down arrow to display a list of available templates the object can be based on. 

To create new objects you can also: 

8 From the Book Contents toolbar, choose the New Topic button. 

8 In the Book Contents, right-click and choose New, then select the object and template 
from the shortcut menu. 

8 In the main Library Explorer right-click an empty area then choose New, then select the 
object and template from the shortcut menu. 

 

This Button Does This 

 
Create New 
Style 

Creates a new Style object based on the last selected 
template. Select the arrow to choose a template from the list 
of Style object Templates.  

 
Create New 
Media Object 

Creates a new Media object based on the last selected 
template. Select the arrow to choose a template from the list 
of Media object Templates.  

 
Create New 
Publishing 
Profile 

Creates a new Publishing Profile.  

 
Create New 
Table of 
Contents 

Creates a new TOC object based on the last selected template. 
Select the arrow to choose a template from the list of TOC 
object Templates.  

 
Create New 
Table of Figures 

Creates a new TOF object. Select the arrow to choose a 
template from the list of TOF object Templates. 

 
Create New 
Index 

Creates a new Index object based on the last selected 
template. Select the arrow to choose a template from the list 
of Index object Templates.  

 
Create New 
Index Entry 

Creates a new Index Entry object based on the last selected 
template. Select the arrow to choose a template from the list 
of Index Entry object Templates.  

 
Create New 
Glossary 

Creates a new Glossary object. Select the arrow to choose a 
template from the list of Glossary object Templates. 

 
Create New 
Title Page 

Creates a new Title Page object based on the last selected 
template. Select the arrow to choose a template from the list 
of Title Page object Templates.  

 
Create New 
Macro 
Procedure 

Creates a new Macro Procedure object. Select the arrow to 
choose a template from the list of Macro Procedure object 
Templates. 
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Manage 

Commands for working with folders, version functions, offline options, XML, and variants are 
found on the Manage tab. 
 

This Button Does This 

 
Create New 
Folder 

Creates a new folder below the selected folder. 

 
Refresh 
Folders 

Refreshes the library's Folder List. 

 
Delete Folder Deletes the selected folder. 

 
Move Folder Opens a window so you choose a new location for the selected 

folder. 

 
Show Folder 
Properties 

Opens the folder's properties. 

 
Rename 
Folder 

Opens a window for renaming the selected folder. 

 
Duplicate 
Object 

Used to create a copy of the selected object, with a new object 
code, and move the object to a specified folder. 

 
Replace Object Replaces one object with another object in all the object's 

relationships. 

 
Create New 
Version 

Used in version control. Creates a new version of a selected object, 
with the same object code. The original version of the object 
remains active until you are ready to make the new version active.  

 
Make Version 
Active 

Used in version control. Makes the selected version of an object 
the active version.  

 
Make Folder 
Available 
Offline 

Makes the objects in the folder available as read only in the offline 
library. The objects cannot be updated in the offline library. 

 
Make Folder 
and 
Descendants 
Available 
Offline 

Makes the objects in the selected folder, and all of its child folders, 
available as read only in the offline library. The objects cannot be 
updated in the offline library. 

 
Checkout 
Folder 

Marks all objects in the folder to be checked out in the offline 
library. Objects added to the folder after you have marked it will 
also be checked out. 

 
Don't 
Checkout 
Folder 

Used to exclude folders (and objects) from the offline library. 

 
Checkout 
Object 

Adds the selected object to the offline folder. 

 
Don't 
Checkout 
Object 

Excludes the selected object from the offline library.  
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This Button Does This 

 
View Objects 
as XML 

Opens a browser window so you can view the selected objects as 
XML. 

 
View Objects 
as XML Style 
sheet 

Opens a browser window so you can view the selected objects as 
XML. This option uses a style sheet. 

 
Save Objects 
as XML 

Saves the selected objects as XML. Opens the Save As dialog box so 
you can name the XML files and save them to a specific location. 

 
Zip and Save 
Objects as 
XML 

Saves and zips the selected objects as XML. Opens the Save As 
dialog box so you can name the XML files and save them to a 
specific location. 

 
Email Objects 
as XML 

Saves the selected objects as XML. Opens an email message with 
the XML files included as attachments. 

 
Zip and Email 
Objects as 
XML 

Saves and zips the selected objects as XML. Opens an email 
message with the zipped XML files included as attachments. 

 
Delete Object Deletes the selected object from the library. 

 
Aspect  Opens the Aspect Book Settings window. Used to assign an Aspect 

Site Reference to a book before publishing into the Aspect 
Database. 

 
Structure 
Builder 

Opens the structure builder for the selected book or topic 
template. 

 Create New 
Variant 

Creates a new variant from the selected object, and applies variant 
criteria as metadata. 

 Edit Variant 
Criteria 

Used to modify the variant criteria, or values, applied to an object. 

 Remove 
Variant 

Removes the link between the variant object and the primary 
object. 

 Convert to 
Variant 

Converts an existing standard object to a variant object. 

 
 

Import  

The Import tab provides the options to import content into your library. 
 

This Button Does This 

 
Word Opens the Select file to import window so you can browse to the 

location of the Word document (.doc).  

 
Rich Text Opens the Select file to import window so you can browse to the 

location of the Rich Text Format document (.rtf).  

 
FrameMaker Opens the Select file to import window so you can browse to the 
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This Button Does This 

location of the FrameMaker file (.mif).  

 
WinHelp Opens the Select file to import window so you can browse to the 

location of the WinHelp file(.rtf).  

 
WinHelp 
Project 

Opens the Select file to import window so you can browse to the 
location of the WinHelp Project file (.hpj).  

 
HTML Help Opens the Select file to import window so you can browse to the 

location of the HTML Help file (.hhp).  

 
RoboHelp Opens the Select file to import window so you can browse to the 

location of the RoboHelp file (.xpj).  

 
HTML Pages Opens the Select file to import window so you can browse to the 

location of the HTML Pages (.html).  

 
Rules Opens the library's Import Rules. 

 
Profiles Opens the library's Import Profiles. 

 
XML Select Author-it XML files or Localization Manager XML files to 

import. 

 
Library Import from another Author-it Library. 

 
Batch Import Imports selected files as a batch import. 

 
 

Publish  

Using the Publish tab, you can select a Book then publish to one of the available profiles. Each 
profile is based on an output type, but can be customized to meet your requirements. 
 

This Button Does This 

 
Print Select an option from the drop-down list to publish to PDF or Word. 

 
Web Select an option from drop-down list to publish to HTML Pages, 

JavaHelp, Oracle Help for Java, Website, or XHTML Pages. 

 
Help Select and option from the drop-down list to publish to HTML Help 

or WinHelp. 

 
XML Select an option to publish to Aspect, DITA or XML. 

 

 

Projects  

The Project Manager Ribbon provides the commands used for working with projects, tasks, 
and actions. 

This Button Does This 

 
Project Creates a new project. Once the project has been created summary 

tasks, milestones, and tasks can be added. 




